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OVERVIEW 

 

A Ph.D. student who is prepared to submit a thesis or dissertation to the university should receive 

approval from the Bauer College of Business. Your dissertation (also referred to as the "manuscript") 

should be submitted to the Dean's Office only after you and your committee members have carefully 

reviewed it to ensure that it is in complete compliance with the requirements stated in this document. 

Remember, your manuscript will be at some point publicly available on the Texas Digital Library. 

Therefore, make sure that the product reflects well on you, your advisor and committee, and this 

university. Treat it as though it becomes a part of your resume on which your future depends.  

In preparation for the submission of a dissertation for publication, degree candidates should consult these 

guidelines early and often for assistance with the formatting of their manuscript. Other resources include 

the Word template and dissertation instruction. Formatting will likely take longer than anticipated, so 

please set yourself up for success by following the formatting guidelines for your own document early in 

the process or using the dissertation templates provided.  

  

https://www.bauer.uh.edu/doctoral/documents/Dissertation-Instructions.pdf?version=230224
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FORMATTING FOR THE ENTIRE DOCUMENT 

File Type 
Students and faculty will use the Vireo system for submission/processing/approval of thesis or 

dissertation material in PDF format. After converting to PDF, please review the entire document to make 

sure that all sections and formatting converted properly, especially images and graphs which may have 

been affected by the conversion. 

Organization of pages 
Pages must appear in the following order 

1. Preliminary Pages: This is the front matter of your dissertation. The Title Page and Copyright 

Notice do not have page numbers. All other pages in this section use lowercase Roman numerals 

for page numbers (ii, iii, iv). Do not add sections that are not listed below; additional sections may 

be included as Appendices. 

A. Title Page (required; no page number but is counted as page i) 

B. Copyright Notice (optional; no page number, but counted as page ii, if included) 

C. Dedication (optional) 

D. Acknowledgment (optional) 

E. Abstract (required) 

F. Table of Contents (required) 

G. List of Tables (required if the main text includes tables) 

H. List of Figures (required if the main text includes illustrations, figures, photos, maps, 

schemes, or pictures) 

2. Main Text: (required) This is the body of your work beginning on page 1. This section uses 

Arabic numerals for page numbers (1, 2, 3). 

a. Chapters must have a title and a number (example: CHAPTER 1: TITLE OF CHAPTER) 

and must be listed in the Table of Contents. 

b. If your dissertation contains multiple essays, assign each essay its own chapter. 

c. The main text section may include Footnotes or Endnotes.  
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3. Appendices (optional)  

4. Bibliography (required) 

 

IMPORTANT: Absolutely nothing may be in the blank margin space. Page numbers, footnotes, 

headers, and any part of any tables, figures, schemes, and text must all be kept out of the margin space.  

Margins on every page of the dissertation must be 1 inch on each side.  

• left margin: 1 inch  

• right margin: 1 inch  

• top margin: 1 inch 

• bottom margin: 1 inch  

Do not use a running head (printing the page title on every single page) in your dissertation.  

Microsoft Word Tip: You may view your margins in Word by using the rulers at the top and side of 

the document. You may also enable Show text boundaries to see if any of your text, images, or frames 

land outside of the margins by following these steps: 

1. Click on the File menu   

2. At the bottom of the left-hand menu, click Options 

3. On the left-hand menu, click on the Advanced tab 

4. Under the heading Show document content, select Show text boundaries 
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Illustration  1: Show text boundaries 

 

Illustration  2: Examples of images inside and outside the text boundaries 
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Fonts 
 

A font 11-12 points in size and a consistent color (black) should be used. We recommend Arial (11pt), 

Calibri (11pt), Georgia (11pt), or Times New Roman (12 pt).  

For footnotes, figures, citations, charts and graphs, a font of 8 points or larger should be used. Italic type 

may be used for quotations, words in a foreign language, occasional emphasis, book titles, or to 

differentiate subheadings. 

When converting your document to PDF, the fonts must be embedded. ProQuest has a how-to guide for 

embedding fonts using Microsoft Word on a PC or Mac. 

Headings and Subheadings 

Preliminary pages and chapters must include headings in ALL CAPITAL LETTERS (example: CHAPTER 

1: TITLE). Headings may be larger than the main text but should not exceed 36 point font nor should 

there be excessive spacing. Headings should be a consistent font color (black) to match the rest of the 

text. You may choose to include subheadings for sections within a chapter; subheadings may be italicized 

or bolded and are not required to be in all capital letters.  

Microsoft Word Tip: By using the Styles menu in Word, you can designate different levels of 

headings to correspond to the chapter headings and subheadings in your dissertation. If you designate 

chapter headings as “Heading 1” and chapter subheadings as “Heading 2,” then your table of contents 

can be accurately and quickly generated using the References tab. See Appendix B.  

Spacing 
 
We require double-spacing the text of your dissertation, including the preliminary pages and the 

Bibliography.  

Text Alignment 

Your main text must be either left-aligned or justified. 

https://support.proquest.com/articledetail?id=kA01W000000k9hkSAA
https://support.proquest.com/articledetail?id=kA01W000000k9hkSAA
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You may choose to indent new paragraphs or sections, but it is not required.  

Pagination 
 

• The Title page DOES NOT have a page number, but for counting purposes, it is considered page 

i. 

• The optional Copyright notice DOES NOT have a page number, but for counting purposes, it is 

considered page ii. 

• The preliminary pages are numbered with lowercase Roman numerals (ii, iii, iv…) from the 

optional Dedication page through the end of the optional Preface. 

• The main text is numbered with Arabic numerals (1, 2, 3) from the first page of Chapter 1 to the 

end of the Bibliography. 

• In Word, the best way to manage the transition from using roman numeral page numbers for the 

preliminary pages and Arabic numerals for the main text is to use a section break. For more 

information on section breaks, visit Microsoft Office Support.  

• Page numbers cannot appear in the blank margin space. 

• Page numbers are recommended to be at the bottom of your page, but you may also choose to 

put them at the top. Whether they are at the bottom or the top of the page, there must still be 1 

inch of blank margin space between the page number and the edge of the page.  

Microsoft Word Tip: In Word, this can be adjusted when you click the page number in the footer. 

The Header & Footer menu will show at the top; in the Position section, increase the Header from Top 

or Footer from Bottom distance to 1 inch.    

https://support.microsoft.com/en-us/office/insert-a-section-break-eef20fd8-e38c-4ba6-a027-e503bdf8375c
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Illustration  3: Adjusting Footer from Bottom to 1 inch 

Landscape Pages 
 

Landscape oriented images and tables are allowed, but they must be formatted as they would be in a 

book: i.e., they are rotated counterclockwise 90 degrees and bound along the top. Landscape pages must 

also have 1 inch margins on all sides. The page number will be on the left side of the page (instead of the 

bottom), and the number will be horizontal. In other words, the page number must appear in the same 

orientation and location as the non-landscape pages. 

The easiest way to format your landscape page is to rotate your image and its caption so that the page 

remains in portrait orientation, but the top of the image is to the left and the bottom of the image is to the 

right. 

For the dissertation approval form (in this document), the “Program” should be Business Administration – 

(your field of specialization). The official fields of specialization at Bauer are Accounting, Finance, 

Management, Management Information Systems, Marketing, and Supply Chain Management. 

 

TITLE PAGE 

The title page is required. View a sample title page in this document.  

• The title page is understood to be page “i” for counting purposes, but no page number should 

be printed on the title page. 

• The title of your dissertation must be centered one inch from the top of the page in all 

UPPERCASE letters. If the title is more than one line, it must be double-spaced.  

https://uh.edu/nsm/_docs/nsm/students/graduate/written-thesis-dissertation-approval-form.pdf
https://uh.edu/graduate-school/academics/thesis/uhgs-template-front-matter-082019.docx
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• Your name on your title page must match your name on your student record at the University of 

Houston. If you want to use a name that differs from the name in the official record, please 

provide the necessary documentation to the Office of the University Registrar. 

• The year must be the current year of your deposit. 

 

COPYRIGHT NOTICE  

The copyright page is optional. The United States does not require you to include a copyright notice or 

formally register to have copyright protections over your work.  

• If you do include a copyright page: 

o Do not put a page number on the copyright page. It is understood to be page “ii.”  

o The page numbers should start appearing on the page after the copyright page and will 

start with “iii”. 

• If you do not include a copyright page, numbering starts on the page after the title page, page ii. 

The copyright page consists of the following line at the center of the page: 

Copyright <Year>, First Name Middle Name Last Name 

1. Do not include the symbol ©. 

2. The <Year> is the year that your dissertation is submitted  

3. The next should be full, legal name with full middle name, and in normal capitalization (e.g., Jane 

Jean Doe).  

  

DEDICATION 

The dedication page is optional.  

• It uses a small Roman numeral page number (ii, iii…). 

• The dedication page does not appear in the Table of Contents.  
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ACKNOWLEDGMENT 

The acknowledgment page is optional.  

• It uses a small Roman numeral page number (ii, iii, iv…). 

• The acknowledgment page header (“ACKNOWLEDGMENT” or “ACKNOWLEDGMENTS” must 

be in ALL UPPERCASE LETTERS.  

• The acknowledgment page must be listed in the Table of Contents.  

 

ABSTRACT 

The abstract page is required. Please pay close attention to the required content, as this page is a 

common source of errors.  

• This page uses a small Roman numeral page number (ii, iii, iv…).  

• The abstract is a condensed summary of the dissertation, not to exceed 350 words.  

• All words, including the title and names, count toward the 350-word total.  

• The abstract page is double-spaced.  

• The abstract page must be listed in the Table of Contents. 

• The abstract, which is normally a single paragraph, consists of four parts: the statement of the 

problem; the procedure and methods used to investigate the problem; the results of the 

investigation; and the conclusions.  

• The dissertation title must match the title on your optional copyright notice and required title page. 

• The dissertation author’s name must match the name on your student record and title page.  

At the top of the page will be these 4-5 lines of text: 

1. The first line is the word "ABSTRACT" in ALL UPPERCASE letters. 

2. The next line is the TITLE of the dissertation in ALL UPPERCASE letters. 
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3. The next line is the author’s (your) name in normal capitalization (e.g., Jane J. Doe). It must 

match your name in the University of Houston system. 

Example: 

 

ABSTRACT 

DISSERTATION TITLE IN ALL UPPERCASE LETTERS 

Caroline Gonzalez Ciccone 

 

The abstract text uses my remaining 340 words, since there are 10 words in the names 

and title. Here I would have a condensed summary of all my research, including the 

statement of the problem; the procedure and methods used to investigate the problem; 

the results of the investigation; and the conclusions.   
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TABLE OF CONTENTS 

 

• It uses small roman numeral page numbers (iii, iv…).  

• The table of contents page is required.  

• The heading must be “TABLE OF CONTENTS” in ALL UPPERCASE LETTERS. 

 

The table of contents must include the following: 

• Acknowledgment (if included in your dissertation) 

• Abstract (required) 

• List of Tables (required if the main text includes tables) 

• List of Illustrations or List of Figures (required if the main text includes illustrations, figures, 

photos, maps, schemes, or pictures) 

• All Chapters (example: CHAPTER 1: TITLE OF CHAPTER, etc.) 

o Subsections – if your text contains subsections, it is recommended to include them in the 

Table of Contents. They should be included in a consistent format.  

• Appendices (if included in your dissertation) 

o Each Appendix must be listed. For example: 

APPENDIX A: TITLE OF APPENDIX 

APPENDIX B: TITLE OF APPENDIX 

• Bibliography 

Microsoft Word Tip: Word allows you to automatically generate a table of contents. By using the 

Styles menu in Word, you can designate different levels of headings to correspond to the chapter 

headings and subheadings in your dissertation. If you designate chapter headings as “Heading 1” and 

chapter subheadings as “Heading 2,” then your table of contents can be accurately and quickly generated 

using the References tab.  



12 
 

You may choose to have your Table of Contents be hyperlinked to sections within your document, but if 

you include hyperlinks, they must be consistent (included for all sections and in a consistent format). 

 

Illustration  4: Selecting Heading 2 in the Styles menu 

To generate a Table of Contents: 

1. Open the References tab from the top menu in Word 

2. Select the Table of Contents drop-down menu 

3. Select a table of contents style 
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4. Whenever you add chapters or subchapters, you can click on your Table of Contents and select 

Update Field and Update Entire Table which will automatically update the listings and page 

numbers.  

5. For more information on how to automatically generate a table of contents in Word, please see: 

https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-

1d8552ccf0c0.  

 

Illustration  5: Adding a Table of Contents from the References tab 

https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
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Illustration  6: Right click and select Update Field to automatically update the Table of Contents 

 

LIST OF TABLES 

 

The List of Tables is required if your document has tables in the text. 

• This page has a small roman numeral page number because it is a preliminary page (ii, iii, iv) 

• It should be titled LIST OF TABLES in ALL UPPERCASE LETTERS. 

• The List of Tables is meant to help readers navigate to the location of each table in the 

manuscript; thus, it is formatted like a table of contents with page numbers for each table.  



15 
 

• Make sure all tables are labeled with a number and title. Numbering must be consecutive and 

match your chosen citation style (e.g., MLA, APA, Chicago). 

• The list itself may be single or double-spaced.  

• The List of Tables must be included in the Table of Contents. 

• Tables in the appendices do not need to be included in the List of Tables. 

Microsoft Word Tip: This list can also be automatically generated in Microsoft Word, if you use the 

References menu to format your table captions. For more information on how to do this, please see this 

short tutorial: https://www.youtube.com/watch?v=z6NP31Q1w3M.  

 

Illustration  7: Inserting a Table caption using the References tab 

 

Once you have captions, you can insert your list using the References tab to select Insert Table of 

Figures.  

https://www.youtube.com/watch?v=z6NP31Q1w3M
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Illustration  8: Using the Table of Figures function in the References tab to make a List of Tables 

 

LIST OF ILLUSTRATIONS OR LIST OF FIGURES 

 

The List of Illustrations or List of Figures is required if your document has illustrations, photos, pictures, 

figures, maps, or schemes in the text. It goes after the List of Tables if you have one, or after the Table of 

Contents if there is no list of Tables. 
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• This page uses a small roman numeral page number (iv, v, vi…) because it is a preliminary page.  

• It must be titled LIST OF ILLUSTRATIONS or LIST OF FIGURES in ALL UPPERCASE 

LETTERS. 

• The List of Illustrations or List of Figures is meant to help readers navigate to the location of each 

illustration or figure in the manuscript; thus, it is formatted like a table of contents with page 

numbers for each illustration or figure.  

• Make sure all illustrations and figures are labeled with a number and title. Numbering must be 

consecutive and match your chosen citation style (e.g., MLA, APA, Chicago). 

• The list itself may be double-spaced or single-spaced (suggested for long lists).  

• The List of Illustrations or List of Figures must be included in the Table of Contents. 

• Illustrations/figures in the appendices do not need to be included in the List of Illustrations or List 

of Figures. 

Microsoft Word Tip: This list can also be automatically generated in Microsoft Word if you use the 

References menu to format your illustration captions. For more information on how to do this, please see 

the section on List of Tables above or this tutorial: https://www.youtube.com/watch?v=z6NP31Q1w3M 

 

OTHER LISTS 

If required by your field, you may choose to include an optional List of Abbreviations or List of Translated 

Words. These lists should be included in the Appendix and should be identified with an appropriate 

heading and formatted similar to the other lists. 

 

MAIN TEXT OF THE DISSERTATION 

 

https://www.youtube.com/watch?v=z6NP31Q1w3M
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• The main body of your dissertation begins with page 1, which will either be an Introduction or 

Chapter 1. 

• From this point on, your pages will have Arabic numerals (1, 2, 3…). 

• All chapters must be numbered.  

• You must include the chapter number and chapter title on the first page of each chapter in ALL 

UPPERCASE LETTERS. 

• Chapters titles and headings should be formatted in a consistent heading style so that they 

appear on your Table of Contents.  

• The font and size of the text should be uniform all the way through.  

• All figures and tables must fit within the prescribed margins: 

CHAPTER 2 

AN EXAMPLE OF A CHAPTER TITLE 

An example of a subheading 

An example of normal text in the chapter. 

 

Tables and Figures in the Text 
 

• Occasionally, charts, tables, maps, graphs, photographs, or figures that are larger than the 

standard page might have to be used in your thesis/dissertation. If so, they should be saved as a 

separate document for uploading, and printed separately for the reader. 

• All figures and tables should be placed within the body of the manuscript and not at the end. 

 

• Each figure and table must have a number and a title. 

o The style of numbering figures and tables should be consistent throughout the 

manuscript. For figures, the full (“Figure”) or abbreviated (“Fig.”) word may be used, but 
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consistently. For tables, the full word “Table” should be used; 

o The numbering of figures can be consecutive from beginning to end of the manuscript 

(Figure 1, Figure 2, etc.) or by chapter (for first chapter: Figure 1.1, Figure 1.2, etc.; for 

second chapter: Figure 2.1, Figure 2.2., etc.). A similar numbering format should be used 

for tables. Figures in appendices should also have captions and numbers (e.g., figure 

A.1, A.2, or A1.1, A2.1); 

o The number and title of a figure must be positioned below the figure; 

o The number and title of a table should be positioned a table above the table. 

• Each figure must have a caption (legend), which is complete enough to be self- contained (i.e., 

the reader should not have to go into the main text to understand the figure). 

o Captions should be single-spaced; 

o Captions should be positioned below the figure, next to the figure number and title; 

o Captions should be on the same page as the figure, unless there is not enough room on 

the page for the whole caption to fit; in this case, the figure number, title, and caption 

should be positioned on the page before the figure. 

 

• If the figure or caption is in landscape mode (rather than portrait), the bottom should be on the 

right (outside) edge of the page; however, the margins remain the same and the page number 

remains at the bottom, as with all other pages. 

 

USING PREVIOUSLY PUBLISHED ARTICLES 

If you include your own previously published work or articles submitted for publication as part of the 

dissertation with the following conditions: 

• You must obtain approval of the dissertation committee and College PhD Program Director. 
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• You must obtain written permission from the copyright owner, which may be the journal, 

publisher, and/or any co-authors, unless you are the sole copyright holder (depends on your 

publishing agreement).  

• You must upload attach the permission letters as a supplemental file titled “Permission Letter – 

Do Not Publish.” 

• For dissertations based on joint work with other researchers, a unique and separate dissertation 

must be presented by each degree candidate. You must include a concise account of your unique 

contribution to the joint work, and remainder of the dissertation must be authored solely by you. 

Authorship of an entire dissertation by more than one degree candidate is not allowed. 

• Your dissertation must be formatted as a single document with consistent formatting and styles 

throughout. If you are using multiple previously published articles, make sure to make the 

formatting consistent with the rest of the document. 

When using previously published or in press work, you must disclose this information in your 

dissertation in the following format:  

• Under the Chapter title, list the full citation for the previously published/in-press article in the 

citation style used in your Bibliography.  

• If it is a jointly authored article, describe your contribution to the work in a separate sentence. 

EXAMPLE: 

CHAPTER 3 

TITLE OF CHAPTER 

This chapter was previously published/is in press as [insert full citation in your citation format: Author 

Name(s). Title of Article. Journal. Year. Link if any]. For jointly authored articles, include a description of 

your contribution to the work. 

Start of Chapter text.  
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REUSING FIGURES OR ANY TYPE OF ILLUSTRATIONS FROM THE LITERATURE 

▪ You may reuse a figure or illustration from your own published articles, as long as you have: 1) 

permission to do so from the publisher (this may be automatic: see Publisher Policies on Pre-

Published Content) and 2) you cite the reference in the figure legend; 

▪ You may NOT reuse a figure or illustration from someone else’s article unless: 1) it has been 

substantively altered or adapted in some way or 2) you have received permission for its reuse. 

In either case, the citation must be made clear. You should treat these issues with as much care 

as you would when submitting an article for consideration with a journal, since you are directly 

liable for any infringement of copyright. It is recommended that you contact the Copyright Team in 

the Libraries for assistance if you have any questions regarding copyrighted material. 

▪ Beware of the meaning of “open access”: only articles that have Creative Commons licenses 

attached to them allow the reproduction of figures. You should always follow the allowances of 

the license attached to that article. Generally, you can reuse anything in an article with a Creative 

Commons license for educational/non-commercial purposes without permission, so long as you 

cite the original author(s). It can occasionally happen, however, that a specific figure or illustration 

contained within an open access article has a separate license attached to it that is more 

restrictive. 

▪ Articles found free online but that do not have a Creative Commons license are under full 

copyright protection and may not be reused or reproduced in any form without written permission 

from the author(s). 

▪ Bottom line: a free online article or an “open access” article may or may not allow reuse of its 

contents. Make sure to check the copyright license for the specific figure you want to reuse. 

 

 

https://libraries.uh.edu/research/communicate/copyright/
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FOOTNOTES OR ENDNOTES 

Notes can appear as footnotes below the text on a page, or as endnotes at the end of each chapter. You 

must choose to use either footnotes or endnotes throughout your dissertation. You cannot vary 

between footnotes and endnotes in different chapters.  

• Footnotes and endnotes must be single-spaced.  

• Footnotes at the bottom of a page must be numbered continuously throughout the dissertation. 

The count must not restart with each chapter. For example, if Chapter 1 has 20 footnotes then the 

footnotes for Chapter 2 should start at 21.  

• A bottom-of-the-page footnote must begin on the same page as the text to which it refers, but it 

may continue on the following page if necessary.  

• Footnotes may never go in the blank margin space. 

• Endnotes at the end of a chapter are numbered separately for each chapter (i.e., the first note of 

each chapter will always be numbered “1”).  

APPENDICES 

Appendices are optional. 

• All Appendices must be labeled with a capital letter. Example: 

APPENDIX A: TITLE OF APPENDIX A 

APPENDIX B: TITLE OF APPENDIX B 

• If you have Appendices for each chapter, they must still go at the end of the main text. You can 

indicate that they refer to a particular chapter in the Appendix title; for example:  

APPENDIX A: SUPPLEMENTAL MATERIAL FOR CHAPTER 4 

APPENDIX B: SUPPLEMENTAL MATERIAL FOR CHAPTER 5 

• You must list all Appendices in the Table of Contents.  

• Tables and Figures in the appendices must be labeled, but do not need to be included in the List 

of Tables or List of Illustrations. 
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BIBLIOGRAPHY 

The Bibliography is required.  

• The Bibliography is an alphabetical listing of all references or a numbered reference list, 

depending on the citation style for your field.  

• If your list is numbered, the entries must be in order of use. 

• Page numbers in the bibliography continue the pagination of the main text; do not number the 

bibliography separately.  

• The Bibliography should be double spaced, but you may choose to single space the text.  

• You may include end-of-chapter bibliographies instead of an end-of-work bibliography if that is 

the standard formatting for your field. 

 

APPENDIX A: USING HEADING STYLES  

This guide uses- and we recommend that you use- an automatically generated Table of Contents. By 

formatting chapters and chapter titles as “Heading 1” and subheadings as “Heading 2” under the Styles 

menu located in the Home tab in Word, your table of contents can be accurately and quickly generated 

and updated. 

To format a chapter title, just select the text and click the Heading 1 button on the Home menu seen in 

the illustration below. 

To change the font size and color of a Heading Style, format the chapter title as you want it to appear, 

then highlight the chapter title. In the Styles menu, right click Heading 1 and select Update Heading 1 to 

Match Selection. This will automatically format all text that is marked as Heading 1. You can use the 

same process to format subheadings using Heading 2. 

Illustration 3.  

Screenshot Of Styles Menu on Home Screen with Heading 1 Selected 
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AVOIDING COMMON ERRORS 

• Oxford commas: In a series consisting of three or more words, phrases, or clauses, separate the 

elements with commas. NSM does not require Oxford commas, but if you use them, remain 

consistent throughout the manuscript; 

Example: The elements included hydrogen, oxygen, and silicon. 

• In headline-style capitalization (often used in titles, table of contents, and bibliographies), do not 

capitalize the second part (or subsequent parts) of a hyphenated compound unless it is a proper noun 

or adjective. 

Examples: Self-regulated Genes; Genes that are Self Regulated; A Twenty-first- century History of 

Science; Helmholtz-Gibbs Equation 

• Use a semicolon between the clauses of compound sentences that are joined by conjunctive adverbs 

such as therefore, hence, however, nevertheless, accordingly, thus, and then. The semicolon 

precedes the adverb, and a comma usually follows it. 

Example: The temperature was much lower than we anticipated; therefore, we did not go outside to work. 

• A comma should follow the words namely, that is, for example, i.e., and e.g. There must also be a 

punctuation mark before each of these expressions, but the kind depends on the nature and 

complexity of the sentence. 

Examples:  
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a) The farmer brought several kinds of animals, namely, pigs, horses, and cows, into the classroom. 

b) The temperature in some areas of the world normally exceeds 100 F; for example, the average 

daytime temperature in Death Valley is 102 F. 

• A verb should agree with its subject in person and number. 

Example: The employer of engineers and scientists has to be careful about hiring practices. ( The word 

employer is a singular subject and requires the singular verb has. Do not confuse the subject with one of 

its modifiers.) 

• A reference using et al. is correctly written as Brady et al., not Brady, et al. or Brady et. al 

• If you punctuate mathematical or chemical equations (e.g., follow with a comma or period), punctuate 

them all and do it correctly. If equations are numbered, do so consistently. 

• The word data may be used in the singular or plural, but remain consistent throughout the 

manuscript. 

Example: The data were inconclusive. OR The data is inconclusive. 

• If you hyphenate a word, be consistent throughout the manuscript. 

• Do not confuse whose with who's or its with it's. 

• The word respectively is set off with commas, or with a comma and a period, if it comes at the end of 

a sentence. 

 


